
InfraWorks Caffeinated Sites Are So Ex-SITE-ing
David Garrigues –  Kimley-Horn
Daniel Philbrick –  Autodesk

CV7237

This extremely dynamic, feature-filled class will help you to analyze, evaluate in context, and
communicate your highly detailed land development site projects using InfraWorks and Civil 3D.
We will use real-world projects, we will show you how to use InfraWorks and Civil 3D models at
the 30%, 60%, 90%, and 100% design stages and present striking fly-throughs for quality-
design checks and public-involvement reviews. Using some basic JavaScript programming
language, we will demonstrate how to effectively import vehicles at the correct rotation angle
and randomize them in your parking lot; we will also show how to quickly develop parking stalls
and other textured areas, including disability-accessible areas and ponds. We’ll also uncover
the secrets of when to use IMX, DAE, SDF, and others file formats to greatly increase your
productivity and drawing-maintenance ability. Lastly, we’ll place this all on a storyboard to
produce a striking client video. We will pack this class with lots of information, so hold on to your
site—hope to see you there.

Learning Objectives
At the end of this class, you will be able to:

· How to get the best materials off the internet

· Learn how to efficiently put together an effective video

· Know which file formats are best suited for different situations

· Have a basic but powerful understanding of Java Script and Filtering

About	the	Speaker
David is the Firm Wide CAD Coordinator for Kimley-Horn and Associates Inc. He has been in the
engineering community for more than 20 years. He worked in the Autodesk Reseller channel for over
eight years. Prior to that, he worked for number of large firms, has been published by CADalyst and
AWWA, and was a popular presenter in many venues, including AU 2005 with his class "Amazing Grade
How Sweet the Ground", "Civil 3D Grading: It's not a Slippery Slope" at AU 2006, and 2007/2008
Caffeinated Grading. As a presenter, David's energetic attitude and enthusiasm make him easy to
understand and relate to.

Daniel is the Director of Product Development for the Civil Infrastructure Product Line at Autodesk, Inc.
In this role, he is responsible for product development of the InfraWorks 360 design capability and
Autodesk® Civil 3D. Daniel joined Autodesk in 1998 and has held various roles in product development
during his tenure at Autodesk. Daniel has presented at Autodesk University many times and enjoys
sharing his product insights with the user community.
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Agenda	
Introduction
Getting Started With the Basics

Setting Up Your First Project
File Formats
Get those Palettes Organized
Creating Good Coverages

Your First Design
Flat Surface
PDF To Raster for Quick Viewing of Site Layout

Improve Your Speed and Delivery Times
Creating In Context: Using Model Builder
Creating In Context: Using Grading Coverages
Leverage Civil 3D for Developing your Site Terrain in InfraWorks
Additional Detailed Design; Roads and Drainage

Making It Come To Life
Label Those Streets
Creating 3D Objects Inside AutoCAD With Materials
Making the Model Realistic: What Makes Good Materials?
Making the Model Realistic: Getting the best models
How to create density with variety especially for vegetation

Understanding Filters and Why Should I
Parking Parking Parking

Understanding Java: Cars In Their Parking Spaces!
Making the Model Realistic: Parking Stripes or Pavement Marking

BONUS: So You Want To See Google inside IW?
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INTRODUCTION
"I don't care what anything was designed to do, I care about what it can do"
- Gene Kranz Apollo 13
That is what this class is all about. Understandably the InfraWorks (IW) product seems to have
more attention in the transportation world than it does in the land development. However, that
does not mean that it is exclusive to roadway projects. On the contrary IW does a great job of
integrating conceptual designs with highly detailed site designs. The strength of IW lies within
how to take an engineering design and convey them in a meaningful 3D presentation.

We have got to start thinking differently. We are the last dog at the bowl. You see what
happens to the runt of the litter? He dies.
- Billy Beane MONEYBALL
I guess it is fair to say that Rule #1 is Don’t Die. To simply ignore that an approach exists that
will help land development project convey their ideas is ridiculous.  However, we must also
understand that IW is much like our projects that last for a couple of years.  Everything is not
ready Day 1, so be patient with your expectations on what IW can do and what it cannot do at
this time. This document will show some best practices that will work.  There are other
approaches and methods, but these will be a great start point for anyone who does land
development.

01-Setting	Up	Your	First	Project	
1. Launch IW 360
2. Probably have to log in using your 360 account (TIP: Administrators make sure they are

only using their company email address when you add them)
3. Select New

4. The current version only allows you to put your projects on the local workstation,
however, this limitation should be rectified in the newer release. We would always
recommend that you store your projects on a network drive.

5. Fill in the areas below. The black horizontal lines represent files in a folder like structure
so you will have to click on them to make the changes.
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6. Next you will get a pretty blue screen with clouds and you will be able to start feeding
this project with all kinds of goodies.

We will also be using several types of file formats so we might as well talk about those
too.

1. SDF vs. SHP- We prefer using SDF over SHP because it is first and foremost only one
file whereas SHP is really multiple files. Currently the major difference is that when you
create objects that are at elevation 0 and your intention is to just drape them on a
surface they behave differently. The SDF must be told in the Draping option on the
Source tab during configure of the import to drape on the surface whereas SHP if no 3D
elevations other than 0 exists it automatically drapes them to the surface regardless.
However, there is a use case for when you just want to bring in lines.  In this case you
can do it with SHP (see more in Showing Contours section).

2. IMX vs. XML- We prefer using IMX over XML because the data is integrated. We
especially like IMX for surfaces.

3. FBX vs. DAE vs. OBJ vs. Whatever- The default answer would be FBX.  The reason is
that it is a native format to Autodesk and the support for that is easier accessed.
However, in a much broader sense you gotta use whatever you can get your hands on,
right?

4. IMAGE Files - JPEG 2000 and Mr.Sid are the two most compressed files however just
know that that whatever you compress IW must also un-compress. So the file store size
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and download times might be something you want to consider. TIF are not as
compressed.  Again, like above, sometimes you might not have a choice, but typically
file size etc. does not make a noticeable difference while working. TIP: PNG files are
great for making single color die cut Jeep stickers. This way the background is
transparent by most online manufactures.

5. REVIT files are also discussed in more detail under the Flat Surfaces portion.

02-	Creating	Good	Coverage’s	for	Exporting	Out	of	Civil	3D	
In the world of land development what we are trying to do is create a consistent method that will
allow us to see rendered materials from inside IW. The easiest way to do this is not to sketch
them while inside IW, but create the geometry inside C3D and export them out to IW and then
set the appropriate materials. To do this we must understand that a single completely closed
boundary around each of our material types is critical. However, it may not be as simple as you
might think especially considering the numerous types of overlapping that can occur on a land
development site and draworder just won’t fix it. To even define with even more granularity think
about creating an outer boundary for a hatch that has islands. We need to create one
continuous boundary or a super boundary that has that cropped look so that we can avoid
those problematic interior boundaries.

In larger subdivisions and more complicated layout plans this may at first seem more
complicated, but in the end you will find that there is a way to get one continuous border every
time. You will find yourself doing this when combining all of your EOP to BOC and Pavement
areas to get one solid “hatch” boundary when trying to get your data into IW. Below is an
example of a subdivision which is about as complicated as it could ever get.  Notice that at this
point we would be able to develop one single hatch… this is exactly what IW would be looking
for so it doesn’t trip over other boundaries “coverages”. OH YA ONE LAST THING: ALWAYS
CLOSE ALL OF YOUR POLYLINES!!!!
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1. Use MapExport at the command line and switch your Files of Type at the bottom to
SDF.

2. Select your objects on the Selection Tab

3. Check the box for Treat closed polylines as polygons

4. Go back into IW and Import them in from Data
Sources as SDF

5. Set the following while inside the Configure
dialog box

a. Set the Type and Materials (you will
need to drill down to get to the actual
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materials you need. However, may I offer up a different scenario? Try just using
color when initially bringing items in. The reason is because sometimes the files
you are bringing in are not correct and you just wasted time on materials when
colors are so much faster.

b. Set the Coordinate system on the
Geo Location Tab

c. Set the Draping on Source Tab

6. Once you bring in the data you may need to adjust the “draworder”. You can do this by
adjusting the Surface Layers. So go into the Data Sources and select the button that looks
like the layers button inside AutoCAD.

What do you have- a dependable method for bringing in boundaries as coverage’s that will
always work.
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03-	Get	those	Palettes	Organized		
OK before we begin there are going to be lots of palettes you are going to use.  We need to get
those organized so they are not all undocked when they probably do not need to be.  To do this
you need to know that there is a difference between how you drag and drop a palette into/on top
of another palette.  When you click and hold on one palette you need to wait till the entire back
ground is that faint teal color NOT JUST THE TOP. Here we already have the Data Sources
and the Style Palette already in Tab format.  However, as we drag and drop here this will result
with the tabs.

If you just get the teal like this then you will get them stacked vertically.

What do you have-  a great way of organizing your palettes!

04-	Flat	Surface		
Let’s say you want to present several different options for a layout. Each of those layouts is
going to take several hours to produce if you also want the 3D aspect.  Why not just show off
the layout in a 2D format with some very simple 3D elements that trick your eyes into thinking
the whole thing is in 3D? Typically we have access to some imagery so this is probably the only
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“critical” item you have to have to do this, but as you will see later on in plotting to PDF it is not a
show stopper.

1. Preparation:
a. Create a surface inside Civil 3D that is in the shape of a rectangle at elevation 0

and export out using the IMX_EXPORT command for that surface.  (TIP: You are
better off creating a dummy drawing and data shortcutting in only the surface you
want to export out. Typically our finished ground surface drawings have a couple
of surfaces in them. But when you deal with IMX it wants to export all the C3D
data objects at once. So to avoid this just data shortcut the surface and bring in
only one surface… THEN IMX out that surface. This way you only have one item
in your IMX file.  The most recent versions of the InfraWorks and Civil 3D
improve this workflow and we’ll cover that topic later in the document.

b. Get some Ariel imagery from whatever current source you use.
c. Take all of your site layout geometry convert them to coverage’s. (section 02)

2. Inside IW import in the surface you created as an IMX and make sure you configure it
and set the coordinate system on the Geo Location Tab. Hit the Close and Refresh
button at the bottom not the OK!

3. Then bring in the image as Raster, again after you configure you have to Close and
Refresh!

4. Lastly bring in all the SDF files as coverage’s and set the appropriate materials.

5. Add additional vegetation as needed. This gives your site height and some depth.
6. Add some buildings.  This has two methods
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a. First we can just bring in the outlines of the buildings as SDF files (vector). Do
this the exact same way as described for coverage’s. Make these type of
changes, but don’t forget to drape!

b. The Second method is an actual model be it either something you got from
AutoCAD, SketchUp, or even better Revit. Bringing in something directly from
REVIT (as long as you have InfraWorks 360; the desktop version alone will do
this but you also need to have Navisworks installed) is a couple of more steps so
we will use that as our example.
So Data Sources> Autodesk Revit RVT> Select your file then it basically uploads
it, converts it up in the cloud, then brings it back, and puts it into your IW project.
You will still have to configure this though.

By using the interactive button you can place your object into the drawing.  Be
prepared though this is a lot easier if you know the insertion point of the object
you are bringing in.
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Oh and while you are trying to adjust the object, after it has come in, its probably
easier to use the Square at the bottom and the Blue UP UCS Z arrow. Be
careful of that cyan top hat button it will start to scale it.

What do you have- The imagery actually gives you depth and you did not have to commit
to any grading with Civil 3D (huge time saver).  Now if your site had lots of relief then it
would show up even better even though it is a flat 2D image. If you have a flat site anyway
then… shoot you’re in good shape already.  In the end look, with very little effort you have a
excellent conceptual representation for your site..

05-	PDF	To	Raster	for	Quick	Viewing	of	Site	Layout	
Let’s do the same thing except this time rather than creating coverage’s we will just create a
raster image of our design and bring it in directly.

METHOD #1 Creating a PDF and Manipulating it to an Image (*Preferred)

1. Go into your site plan drawing inside C3D
2. Set all of your layer colors to true color in this case 252,252,252
3. Plot DWG to PDF
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4. I know once this happens your PDF comes out looking white.  But it is not. It’s actually
two different colors.  Do not panic.

5. Open a PDF editor like Adobe or in this case Acroplot Matrix. The next two options show
how to use those applications then the instructions will continue at the bottom.

A. For AcroPlot Users you can do it this way

1. It is important to note that we are changing the background to a color that looks more
like pavement.

2. Now we export out that out as an image. We are showing 400 dpi but as you should
know the higher the dpi the larger the image.

B. For Photoshop you can do it this way
1. Open your PDF in Photoshop
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2. On the layer panel Create a New Layer

3. Move Layer 2 below Layer 1 by dragging it down in the list
4. Select the foreground in the color panel and change it to something like Dark Gray or

Black

5. This is kind of tricky so pay attention. Select the Bottom layer (Layer 2) and then use the
ALT+Delete key at the same time. (this fills the layer with your foreground color, which is
now dark gray as you selected earlier)

6. Save the file as a TIFF.  You will be prompted for some settings this is what we use.
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Continue with the import into Civil 3D

6. Go into C3D and import in the image using Raster Design.
7. Manually scale and place the image where it lays directly on top of the site.
8. Create a World File using the IWorldOut Raster Design Command
9. Now you have a World file for your image in the exact place it needs to be Geo-Rectified

if you will.
10. Go into IW and import the Raster file and it should lay directly on top of your site.

METHOD #2 Creating an image directly while inside Civil 3D Using Raster

1. Inside C3D zoom to the extents of the geometry you want to display.
2. Make sure Raster Design is loaded
3. Raster Tools>Insert & Write> New (iNew Command) and change your density and it is

probably easier to just use the pick button to set your origin, width, and height. I always
have my rotation set to 0 and I always start at the bottom left corner cause that is the
way I roll.

4. Raster Tools>Insert & Write> Save (iSave Command) save it to your project folder.
5. Raster Tools>Insert & Write> World File (iWorldOut Command) this saves out everything

so that it will line up with your coordinate systems.
6. Raster Tools>Edit> Merge Vector (ivMerge Command) select the vectors you want to

add to your image.
7. Raster Tools>Insert & Write> Save this way the image is good to go.
8. Now we ready for InfraWorks.
9. After the raster has been imported and while inside the Data Source Configuration

(configure) on the Raster Tab there is an option for Color Mask.  Simply select the



InfraWorks Caffeinated Sites Are So Ex-SITE-ing

15

ellipses button on the far right side to launch the Pick Color dialog box.  Inside this box
you will be able to use the Pick Screen Color button or just hit the BLACK color (HTML:
#000000)

10. Your image should now be draped on your surface and the color of your background
should be transparent.

What do you have- You have condensed the time needed to put your linework in your
drawing. Whatever you had be it just 2D line work or hatches it should have come out
exactly as you had it set inside C3D. No need to create coverages. The upside to this
method is that the need to create boundaries is gone. The downside is that you don’t have
an exact replica in some cases for the “look” you might be trying to achieve. Truly this is
quick and dirty, but not as dirty as taking your Jeep out mudding.

06-	Creating	In	Context:	Using	Model	Builder	
Model Builder at the time of this document is in a preview stage. What it will do is go out and
gather roadway and building information from OpenStreetMap’s, imagery from Bing, and the
land elevation data from USGS with 10-30 DEM Data. It makes for a great starting point.

1. When you first start IW make sure you turn it on

2. Now go up to the top and select the Model Builder Command

3. Type in your address in this case I will use
Mandalay Bay Las Vegas

4. It takes me to that location where I can zoom and get familiar with the area I want to
have downloaded.

5. I have two buttons right below the search. The first will grab what you current view is
whereas the second lets you create a bounding box. (I typically use the bounding box)
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6. One special note is that there is a limit to what you can download.  You can’t be over
150 sq. km (93.21 sq. miles).  If you exceed this limit it turns red to let you know you
have exceeded the max.

7. Once you do this it will take about 15 min. and you will get an email link and you will then
be available for you to download at the bottom of your IW initial window under Online
Models.

8. Now that you have data all you have to do is just drape your coverage’s like you did for
the Flat Surfaces and you should be done.

What do you have- Now you have a true surface that was created based upon USGS
information. This is highly effective and did not take that much time at all.  Plus you have
building heights (if that level of information was available) and roads.  Note that the
roads did come in generically so some of them probably needto have their styles
swapped.

07-	Creating	In	Context:	Using	Grading	Coverages		
1. You have two choices you can either bring in some geometry via SDF that make for the

outline of your pavement areas or you can sketch them in using the Coverage Tool
inside IW. We will assume you have simple rectangle representing a site and our goal is
to create a single drainage swale in the middle. The one thing you will notice is that time
that it takes to do this is somewhat slow so this is just to show what you can do. I would
suspect that in future versions this would be much faster making this a more viable
option for large pavement areas like parking lots etc.

2. Select the coverage and right click and select Edit.  This puts you into Edit mode. Now
when you select it you should get the CYAN top hats and be able to adjust some of the
sides.

Adding a Coverage Inside a Coverage
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3. Next you can add another Coverage inside the one
you have already created to represent a low point or
swale line. I will use a 3 Point coverage.  Keep in
mind you can put these really close together I put
mine with a little bit of distance so you can see what
is going on.

4. Now I am going to adjust the Left side of the new swale by lowering the Top Hat. You
will notice that NO CHANGE WILL OCCUR.
The reason is because these two coverages
are interconnected.  The only way to get the
interior coverage to obey is to make the tinest
of change the outer coverage.  To do this, while
in edit mode, attempt to edit one of the top
hats.  Instead of dragging it up or down simply
just the tool tip edit window to change your
coverage by .01 up or down doesn’t matter.

5.  Any time you make a change to the interior coverage you will need to make a tiny
change the exterior coverage to see the update. In fact most of the time you will notice
that when you modify your interior coverage it will appear as though it has reverted to
just draping itself back on to the exterior coverage.  Again making that small change to
the exterior will update the interior. Not ideal necessarily, but it works.  I have been told
this has been improved in the most recent version but at time of publishing the paper did
not verify.  Check out the new versions for yourselves!

6. Lastly no one wants to see your hideous color scheming for your grading.  So you might
want to use whatever current backdrop you have (maybe even that PDF trick we showed
earlier). So we need to make these transparent so the grading shows through.

7. You can make a transparent hatch by setting your style to look like this.
That is (6) 0’s for the outline style and the width is set to 0.00000001 ft
TIP: Just remember 6-0’s then 7-0’s like a 1967 Chevelle cause there ain’t nothin hotter
than that.
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What do you have- A relatively quick way of doing some rough grading.  It is better to think
of this as extremely conceptual, but do not get carried away with this.  Using C3D to create
curbs, swales, islands, etc. is the program of choice to make any fine detailed grading.

08-	Leverage	Civil	3D	for	Developing	your	Site	Terrain	in	InfraWorks	
This is something you are bound to want to do.  At some point you have settled on a site layout
and began your grading inside C3D using feature lines. It is also fair to say that your EG surface
that you received from the surveyor is better than the one that comes from Model Builder.  But it
is also fair to say that the amount of data that Model Builder gave us cannot be ignored. So how
can we merge this interaction of these three types of surfaces?  There are two good ways of
incorporating a Civil 3D Surface into InfraWorks.

Workflow 1

1. EG from C3D export out as IMX
2. FG from C3D export out as IMX
3. Assume you already have a surface from Model Builder
4. Bring each of the items as a data source inside IW and set the order with the Surface

Layers tool.

As you make changes to your surface in Civil 3D, just re-export the IMX file and update your FG
surface in InfraWorks. That way you will continually have an accurate, visually compelling model
in InfraWorks.

The second way to leverage an FG surface from Civil 3D involves using capability that is being
released in conjunction with Autodesk University 2014.   You will need to install InfraWorks
2015.3, Civil 3D 2015 SP2 & The Civil 3D Productivity Pack.  All of these will be available
shortly after you return to your office.   Let’s take a look at the second workflow using the new
capability.

Workflow 2

1. Use Model Builder inside IW for your project site
2. Launch C3D and issue the Open InfraWorks Model from the toolbox
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3. With this command, you are now able to read the InfraWorks model directly and
specifically select what data you want work with in C3D.

4. The first step is to select the InfraWorks model and make sure you set the appropriate
coordinate system in Civil 3D.

5. Often times, you may want to just work with a portion of the InfraWorks model and there
is a great option to let you select the “Area of Interest”. This will display a map from the
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online maps service, as long as you are signed into Autodesk 360. This image provides
perfect context to ensure you bring the right data into C3D.

6. Once you have selected your model and the Area of Interest, as a last step you can
refine you selection set. This is quite useful if there is just a subset of the data that you
want to work with in C3D.

7. In order to refine the terrain in Civil 3D, you will want to import the
AIW_Existing_Ground, Design Roads, and Coverages. For now we’ll just focus on the
Terrain and look at other data types in the next section.

8. Leveraging the Grading tools in Civil 3D, a Terrain surface was created that can easily
be directly imported in the InfraWorks. In the following example you can see the original
concept in InfraWorks and the refined detailed design in Civil 3D.  Now we can very
easily incorporate this terrain into InfraWorks.

9. From within InfraWorks, you will see a new option in the Data Sources panel.  Select
that option and browse directly to your Civil 3D dwg.
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10. Now you can go through and select the correct data you want to incorporate into the
InfraWorks model. For example, we just want to bring in the new surfaces and configure
those elements.

We now see a concept that contains additional detailed design modeled in Civil 3D.

11. There is now a connection between the C3D drawing and InfraWorks.  Each time you
modify the terrain in Civil 3D, all you have to do is reimport the data and that surface will
update accordingly.   This will enable you to refine your detailed design and immediately
have compelling in-context visuals for stakeholder engagement.
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What do you have- Something pretty kick butt that you can show off. Very detailed on the
inside and lots additional data by the Model Builder to put our site in context of the overall
scheme of what we are trying to do.

09-	Additional	Detailed	Design;	Roads	and	Drainage	
Typically you will need to create access roads and drainage systems for your site. InfraWorks
has the ability to sketch in conceptual roads and utilities but if you have InfraWorks 360 you can
leverage the Roadway & Drainage purchased entitlements. Furthering the workflow, these
Roads and Drainage networks can be imported into Civil 3D for detailed design. Let’s take a
look at a workflow that incorporates drainage and corridors into your site plan.

1. Inside IW sketch in roads using either the planning roads or designed roads. If you have
InfraWorks 360 you can create designed roads in the context of your site. In the
example, we’ll also add drainage network to one of the roads.

2. Open C3D run the command in the toolbox called Open InfraWorks Model. In this
example we’ll select a portion of the InfraWorks model and bring that right into Civil 3D.
What you will see is the Alignments, Intersections, Pipe Networks, Surface & Coverage
all are available in Civil 3D. If you take a look at the Pipe Networks parts, you will see
they are identical parts in InfraWorks and Civil 3D.

3. Next we can now complete Detail Design in Civil 3D. In this example, we’ll build out the
corridor for detailed design. Once we have the Corridor design we like, the next step will
be to simply bring that back into InfraWorks.

4. Jumping back into InfraWorks, select the Data Sources-> Autodesk AutoCAD Civil 3D
source and now just select the Roads, Corridor Surface and Coverages from the
following dialog.
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5. You will then configure and import the data. One step we need to remember is that is not
necessary to bring all the data back into InfraWorks.  In the dialog below, I am only
selecting the Roads that we refined using the  corridor modeling tools  in Civil 3D. The
other roads have not changed so there is no need to import.

6. Once we have the data configured, now we have the exact corridor plus you have
coverages!

What do you have- A better understanding of how you can leverage detailed design
corridors in Civil 3D.  And furthermore, if you modify the corridor in Civil 3D, all you have to
do is reimport the data from that drawing and the InfraWorks model is updated!
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10-	Label	Those	Streets	
Great now we have roads lets go label some of them. OK so labeling a street like we would
normally see on a plan has not been addressed yet inside IW. Sure there are Points of Interest,
but sheesh we want to see some text!  How do we do this? Simple we go back to AutoCAD.

1. Let’s say we want a street called BLAND ST. using either Arial or Century Font. I pick
this particular road name because you will notice that the letters B, A, and D all have
closed internal boundaries. This will become apparent why this is important here in a
couple of steps.

2. Set your layer to something that has a layer color that is different than white.
3. Go ahead and create some text in AutoCAD and type in BLAND ST.
4. Express Tools > Text > Modify Text > Explode (or you could just type in TxtExp)
5. This will sometimes hang a little but don’t panic.  You

should get a new funky looking text like this.  (I made copy
and moved it down then exploded the one on the bottom
for clairity)

6. Now switch your layer to something else that has a different color
7. Run the Extrude command
8. Use the value of 10 when prompted for the Height.
9. The polylines that did not extrude will remain the same color.
10. You will see that above the D has some red in it.

The reason is because that portion did not
extrude. This is going to sound crazy but the
reality is that you can run this command several
times and it will seem to run differently almost
every time.  In this case it happens to be the D the next time it might be the B or the S.

11. The question is how do you fix it? What is happening is that when it
changed the Text into a Polyline it sometimes creates vertices on top of
vertices. All you have to do is get rid of them.

12. If we look at the top of the D we will see our culprit.  Remove this vertex and check out
the bottom as well for any extra verticies.

13. Next use the extrude command on those previously uncooperative polylines.
14. All you have to do now is make a Model out of this using FBX.
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15. One thing that might be helpful is to orient your model like this and move your object
based upon a point on the text somewhere in the middle of the entire string of text like
so.

16. Now move it from that point to 0,0

17. Now run the FBXExport command, give it a name, and then make sure you pick the
Selected Entities option.

18. Go into IW and under Data Sources Chose 3D Model

19. Set your type to City Furniture and leave it in the XY-M or XY-FT (FT is foot) but I don’t
think it has mattered to me that much.
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20. Pick a spot on your site and your site and you should see it. Now this one does not have
any color or texture assigned to it.  However, later on in this document there is a section
that covers materials this will get you want.

21. If you rotate the properties of this object to -90 in the Y direction for the Rotation Y, you
will get this

What did you learn: How to create a 3D object by extruding it from a 2D Polyline and
export that as something that can be used as a 3D object inside IW. In this case it was
text but it could be anything.

11-	Creating	3D	Objects	Inside	AutoCAD	With	Materials	
1. Inside C3D use either the BOX command or create a rectangle that is 1x1 and then use

the extrude command with a value of 1. Both of these will result in a 3D Solid.
2. You have a choice!  IW wants to convert everything realistically to LL84 which is metric.

99.999% of the time for those of us in the US we work in Feet. So this presents a
problem in the way you create content then bring it into IW.  I would consider most
objects we are going to use (fire hydrants, light poles, etc.) to be brought into IW via the
Style Palette>3D Model, however, you could also use the Data Sources>City Furniture
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as well. Unfortunately because these two work differently in how the data is converted
when imported it makes a difference in how you scale it prior to exporting the 3D Object.
If you prefer to use City Furniture option you need to scale your object down by
0.3048006096. Leaving it at (1) one you will be able to use it in Data Sources.

3. Now that you have your object made you need to do two more things just to get the
material to apply to your object.  You need to create the material, and add it to your
object.

4. Create the material by using the MATERIALS command (be careful it is plural with an S)
5. Go the bottom icon and select it and then select New Generic Material…

6. We want to create a Transparent Block in this case

7. When you close out of that box the name should appear in the MATERIALS BROWSER
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8. You can either, select the material and drag and drop it onto your object directly OR you
can just select your object and change the Material property (in the Properties Palette) to
your new material style.

9. I then make sure that my object is at 0,0 (either centered or begin in the positive xy) and
set the drawing to plan view by using the PLAN command and hitting ENTER two times.

10. Use the FBXEXPORT command and make sure you use the Selected Entities option
instead of the visible as that might get you into trouble in some instances and select your
objects directly.

11. Remember that scaling issue we talked about earlier… well now that makes a
difference. If you preformed the conversion simply add it to your Style Palette under 3D
Model/City Furniture and add your objects like normal. If you did not perform the
conversion you need to bring the data in via the Data Sources with 3D Model and still
use City Furniture, but use the Interactive placing at the bottom when in the
configuration.

What do you have- A better knowledge of how to export models just using regular
AutoCAD.  However, at the making of this class the translation issue seems to only be a
problem with this release.  Look forward to future releases where the conversion may be a
non-issue.
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12-	Making	the	Model	Realistic:	What	Makes	Good	Materials?	
Materials are a peculiar little topic and the only way to understand what we should expect from
them is to understand them in contrast from one to
another. Let’s face it the internet is awesome and it can
be used for more than just looking up Jeep Parts!  So
what we need to do is get some materials that are the
best that the internet has to offer.  Materials are really
images right? Right! Have you ever seen a grass
surface on some visualization projects that just look
like a bunch of green images all tiled together? Here is
Material/Land Cover/Tall Grass that is one of the defaults inside IW.

The repeating pattern is annoying because it does not look natural.  Same thing with pavement
and concrete, they all end up with this repeating pattern business. There are two ways to
prevent this, the first is Seamless Images and the Second is adjusting scale.

Like in movie making the need to hire a bunch of folks in big crowd scenes is unnecessary.
They just copy a portion of folks over and over again.  Same thing goes for images that have to
cover vast amounts of ground. What we need to find is images that have a pattern whose edges
blend together so that the sides do not create issue of looking like a pattern. So, whenever you
search for a particular material type make sure you search for Seamless. Here are some
examples.

1. Use Google c’mon how hard is that. When searching switch to the Images tab and select
the Search Tools then change the Any Size to Large.

2. Type in Grass Seamless

3. You can also go to www.GoodTextures.com then go down on the left and select
Seamless Textures, as well as other sites that will help you create some of your
own like http://freeseamlesstextures.com/photoshop-tutorial.html

4. Add these to your style palette under materials
5. You will notice that some are better than others. Try a few on a big area and you will

notice that you no longer have the tiled look, but instead something that looks natural.

http://www.GoodTextures.com/
http://freeseamlesstextures.com/photoshop-tutorial.html
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The second way is adjusting your scale for the pattern that you already have.  For instance
that pattern we used before Material/Land Cover/Tall Grass can also be adjusted so it is
not as noticeable. Style Palette> Material> Tall Grass> Select it and pick the pencil (EDIT) at
the bottom. Change both of these from the 3.28083990 ft to let’s say 20 or 40 and you will
get this!

What do you have- Not only a better understanding of how to use the internet, but how to
search for better materials and how they work when scaled.

13-	Making	the	Model	Realistic:	Getting	the	best	models	
There are several different types of object types out there FBX, DAE, OBJ, DXF, 3DS, or SKP
just to name a few.  Lots of these can be found on the on the internet and here are a few to start
with.

1. 3dwarehouse.sketchup.com
2. TurboSquid.com
3. 3DCadBrowser.com

Of course you can always go create your own inside AutoCAD or 3DS Max or Sketchup.
But how do we get those in?  Well if you have a sketchup model you can bring that into C3D
if you use the SketchUp Import command found on Autodesk Exchange. The other files
can natively be brought in directly using the 3D Model option inside either the Style Palette
or Data Sources.  The only problem is sometimes the models you get are created in varying
units so you have to deal with that in the properties for each object.

What do you have- A Couple of more solutions for getting free data.

14-	How	to	create	density	with	variety	especially	for	vegetation	
A lot of times we get the increase the density of a stand or row of trees or bushes but we want
these to have a varity.Getting a little introduction into JAVA would go a long way.. and hey its
not only pretty easy it’s fun! Let’s first select that Edit button on the top.

1.
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2. Stand of Trees
3. Create an area (hit enter or double left pick to stop creating the area)
4. Select one of them and Right Click and select Edit (you are now in Edit Mode)
5. Slow Double click on one of the Trees (again S L O W double pick) This should select all

of the trees.
6. Now we get the slider bar go ahead and adjust the density

7. Right click and go to properties and change the description that is unique like
IncreaseMyDensity or something that may make more sense to you. I would encourage
you to use something simple. (TIP copy that text to the clipboard, I also prefer  to use
upper lower case with no space as you  can see)

8. You have just set the description on ONLY this set of trees. Keep this in mind as you
might get confused later on.

9. Then hit the update button at the top right hand corner of the properties box.
10. Go into Style Rules and create a new Rule Style and edit the following way.

The Expression is DESCRIPTION LIKE ‘IncreaseMyDensity’
The Styles are just trees that I picked by hitting the Add button.  However you also need
to pay special attention to the numbered column. What this is allowing me to do is
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randomize the trees I should get 3X the amount of Yellow trees as I do the Aesculus
trees.

11. Next you need to hit the Run Rules button

12. Go back to the Properties Palette and take off the Manual Style for that stand of trees
and then hit update in the upper right hand corner

13. Now let’s say you want to increase the density again.  Slow double click on the trees
again and change the density. (i.e. you use the slider bar)

14. Your Description has now been removed from all the trees because you really
have NEW TREES. So you need to now go and add the same description to these
“NEW” trees. It may seem like this is bogus, but you really do have a totally different set
of trees now (Spok from Star Trek would agree that the logic is sound). Think about it;
you re-randomized them.

15. Update the Description in the Properties Palette
16. Go back to style rules and run the rules
17. Go back to Properties and remove the manual style and make sure you hit the Update

button.

What do you have- A better understanding of how to apply style rules and not only
increase the density of a tree area (rows or stand), but randomize the vegetation as well.

15-	Understanding	Filters	and	Why	Should	I?	
Filters provide us with the ability to search for objects in our drawing. At some point this will be
something you are going to want to do.  Below are a couple of instances of how this will be
useful in our day to day tasks.

Simple Select Items Listed in the Data Sources Tab

1. Right Click on the data source and pick the Select Features option
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2. Now it did select them and it still might be hard to know where they are located.
3. So if you pick inside IW one time anywhere, but preferably somewhere in space and not

on an object, then hit your F key on your keyboard it should put the entire selection in
your view Frame window. Get it F for view Frame.

Select Feature that was based upon Rule Style from the Filter

Grab all Trees whose name is 3D Model/Vegetation/T19-V03 Dark Red so let’s go grab the
Filter Select Button

1.

2.

3. Select OK
4. Now all the trees that match that description are highlighted in your design area.

Select Feature that was Based upon Rule Style from Model Explorer

1. Probe down into Model Explorer and find Vegetation and select Filter Select.

2. Fill in like below and hit OK at the bottom

3. They should all be highlighted



InfraWorks Caffeinated Sites Are So Ex-SITE-ing

34

Create a Filter Subset from Model Explorer

1. Now you can also create a subset of a filter so that you can later on recall that selection.
To do this simply right click on the item in the Model Explorer as you did before except
this time select Create Subset. This one is now stored. (note at the time of this writing
there seems to be bug in that it does not recall the selection all the time).

What do you have- While this is not as easy to do as say inside AutoCAD it is the way to find
your objects. An interesting type of fact: IW is a database that has the ability to look at the
source of where objects come from and at the same time allow you to manipulate objects after
they have come into the IW project.  So take a minute to let that concept absorb. Typically if you
adjust an object inside IW after you have imported it and then later on you refresh the data
source… then your adjustments to the object will revert to what the source says. This is also the
reason that makes finding items seem a little more difficult and the need for filtering.

16-	Understanding	Java:	Cars	In	Their	Parking	Spaces!	
Well if you are in Land Development eventually someone is going to want a parking lot. And hey
someone is then going to ask…”Can we put some cars in there?” You are going to say yes, but
then you are going to discover that placing cars in through City Furniture is going to be an
exhaustive process by the time you self-randomize those vehicles and get them all turned at the
correct rotation angle in the parking spaces. You can do that if you want on something small for
sure but if you are talking 20-50-200 cars you are in trouble my friend. This then becomes a
time you will wish you understood how to script. Now this method does make it to where you
would place each of your vehicles inside Civil 3D, but this is far easier to do that than manually
placing and rotating inside IW (fo realzeez, no joke).

1. Create several blocks they can just be lines with a pointer like so  The secret is to let
them be different colors and somewhat different shapes, but they should have some kind
of identifying piece that shows the direction of North being 0 like shown. I have created
two blocks one called Large Car and the other called Small Car.

2. Next place these around your site in the parking spaces some facing in and some facing
out as if they backed in.

3. While still inside C3D we need to export out the those blocks (cars) by using the
MAPEXPORT command using the SDF format.

4.



InfraWorks Caffeinated Sites Are So Ex-SITE-ing

35

5.

6.

7. Select OK one more time

8.

9. Now we go into IW and simply Go to Data Sources>SDF and select our file.
10. Next Right click on the our data and select Configure
11. Set the Type at the top to City Furniture and set your Coordinate System on the Geo

Location Tab.
12. On the source tab set the Draping option to Drape.
13. Next just jump straight to the Script tab and click the Edit button and copy and

paste one of the scripts text below into the editor window.
14. INTERMISSION: Time to get some coffee Java

Java is a scripting program and does not take much to learn.  I would recommend
downloading Notepad++.  Below here are a few examples of how to randomize our
vehicles. I think you will be able to follow the logic but basically all that is happening in
the first script is that we are substituting a block from a drawing called “Small Car” to
either Blue Compact Car, Lexus 430, or Honda Accord.  But what if the user selected
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other blocks that did not have the name called “Small Car” that is where the ELSE
comes in, we then make it be a Ford Explorer.  The second example demonstrates that
you have a superior knowledge of how the real world looks, it has more than just these 4
types of vehicles. This one assumes you have enough forethought to create instances
for both Small and Large cars.  You can see in this one we are doing 2 different
randomizations.

JAVA EXAMPLE 1

function Process(SOURCE, CITY_FURNITURE) {
// Allows for 1 block named Small Car if you have other names then it will just drop in a For Explorer
CITY_FURNITURE.DESCRIPTION = SOURCE["ROTATION"];
CITY_FURNITURE.EXTERNAL_ID = SOURCE["FeatId"];
CITY_FURNITURE.MODEL_ROTATE_Z = ((SOURCE["ROTATION"] * 57.295779500000002) - 90);
CITY_FURNITURE.NAME = SOURCE["BLOCKNAME"];
if (CITY_FURNITURE.NAME == "Small Car") {
switch (Math.floor(Math.random() * 3)) {
case 0:
CITY_FURNITURE.RULE_STYLE = "3D Model/Vehicles/Blue Compact Car";
break;
case 1:
CITY_FURNITURE.RULE_STYLE = "3D Model/Vehicles/Lexus 430";
break;
default:
CITY_FURNITURE.RULE_STYLE = "3D Model/Vehicles/Honda Accord";
}
} else
CITY_FURNITURE.RULE_STYLE = "3D Model/Vehicles/Ford Explorer";
return true;
}

JAVA EXAMPLE 2

function Process(SOURCE, CITY_FURNITURE) {
 // Allows for 2 blocks named Small Car and Large Car if neither of these are the name use Ford Explorer
 CITY_FURNITURE.DESCRIPTION = SOURCE["ROTATION"];
 CITY_FURNITURE.EXTERNAL_ID = SOURCE["FeatId"];
 CITY_FURNITURE.MODEL_ROTATE_Z = ((SOURCE["ROTATION"] * 57.295779500000002) + 90);
 CITY_FURNITURE.NAME = SOURCE["BLOCKNAME"];
 if (CITY_FURNITURE.NAME == "Small Car") {

switch (Math.floor(Math.random() * 3)) {
case 0:

CITY_FURNITURE.RULE_STYLE = "3D Model/Vehicles/Blue Compact Car";
break;

case 1:
CITY_FURNITURE.RULE_STYLE = "3D Model/Vehicles/Lexus 430";
break;

default:
CITY_FURNITURE.RULE_STYLE = "3D Model/Vehicles/Honda Accord";

}
 } else if (CITY_FURNITURE.NAME == "Large Car") {

switch (Math.floor(Math.random() * 3)) {
case 0:

CITY_FURNITURE.RULE_STYLE = "3D Model/Vehicles/Green Jeep";
break;

case 1:
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CITY_FURNITURE.RULE_STYLE = "3D Model/Vehicles/Volvo Sedan";
break;

default:
CITY_FURNITURE.RULE_STYLE = "3D Model/Vehicles/Audi A8";

}
 } else

CITY_FURNITURE.RULE_STYLE = "3D Model/Vehicles/Ford Explorer";
 return true;
}

15. Kick back and watch the magic happen!

What do you have- A better understanding of how you can utilize Java and Scripting to
help with other kinds of tasks inside IW.  The cool thing about knowing this is you can also
go out and create all your road city furniture like turn arrows, stop bars, cars on a road, etc.
The only problem with City Furniture like cars is that in steep grade conditions you will notice
the vehicle comes in flat even the surface is at a grade… so sometimes the object looks like
it is grinding into the surface.

17-	Making	the	Model	Realistic:	Parking	Stripes	or	Pavement	Marking	
This is very simple tool that we have created that will help you actually place parking stripes on
your project with ease. The code is very simple all it does is offset a polyline to both sides and
then closes the top and bottom to create a closed polyline to be used as a coverage. The
reason we use SDF in this case is because if we were to us SHP “lines” as opposed to closed
boundaries the lines tend to sometimes get buried under the surface at random. The best way
to control that is using SDF.

1. The routine can be downloaded from where this document was also downloaded. You
will need to load this routine into your session.  YOU WILL ALSO need to download and
make sure that the doslib functions are also loaded as well. Download the routine from
here http://www.rhino3d.com/download/none/none/doslib

2. Run the PlinesToOffsetAreas command inside Civil 3D
3. Select the objects and watch them get converted
4. Export out the parking stripes as SDF.
5. Import to IW as a coverage.

http://www.rhino3d.com/download/none/none/doslib
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What do you have- A very accurate representation of your parking lot or roadway
surface

18-	Making	the	Model	Realistic:	Showing	Contours	on	Top	of	your	Design	
Some sites have less relief causing visualization to be somewhat more difficult.  One way to
show off your actual 3D design surface from Civil 3D is to export out the contours as SHP.  The
reason you are using SHP is because it is not going to present problems when you bring in non-
closed polylines as boundaries. We can thicken the contours with a coverage style later on.

1. Assuming you have a C3D surface go ahead and change the interval to what would be
suitable. Because the site I am working is relatively flat I am going to use 0.1 contours.

2. Select the surface and from the ribbon select Surface Tools> Extract Objects
3. I will select both Major and Minor and select OK

4. Next you will want to run the MapExport command again

5. Change the file type to  and give it a name
and select OK

6. Selection Tab Check the Line and select your objects

7. Next goto Options and Pick on the Driver Options at the bottom

8. Next you will select the 3 Dimensional Shape Files
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9. Select OK again and now you have your SHP files ready to be loaded into IW.
10. Go into IW and import from data sources the SHP file
11. Change your Type at the top to Coverage
12. Change the Geo Location to your source
13. On the Source tab change it to Drape
14. On the Table tab change your style to oh… let’s say 'Coverage/Restricted Area'
15. On the Table Tab change the Buffer to something like 0.25
16. Select Close and Refresh you should see your contours on your drawing.

TIP: You could actually export out your Majors and Minors separately this way you can
show them off as two different colors or widths. Obviously you could also create a new
or modified style too J.

19-	So	You	Want	To	See	Google	inside	IW?	
This is pretty crazy stuff and certainly not typical but it is pretty cool. This will allow you to
perform Google searches while inside IW using a script. This has a pretty nice interface, but
requires you to do a little bit of setup.  The script for this is pretty small but you can download it
from where you got this downloaded. Here are some instructions that will have to be performed
to get this to work.

1. Go to https://console.developers.google.com/project?utm_referrer=blank
2. Create a project
3. Now goto APIs and add the following API’s

4.

5. Create some Credentials and a New Key

https://console.developers.google.com/project?utm_referrer=blank
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6. Copy the Key you get into the file called GooglePlacesSearch.js
7. And replace that with the line that reads

var key = "ThisWouldNeedToBeChangedToYourKeySoDoIt";
8. Next you need to go into IW and under Settings and Utilities: Run the Script command and

just load up the file you have and run it.

20-	Secrets	to	Making	a	Great	Video	
There are certainly tons of documentation out there on the internet and demonstrated at AU that
cover making a video.  So I will not bore you with the details of setting it up from scratch, but I
will go over the essentials of what it takes to make a very clean non-nauseating video.

Inside IW there are essentially only a few commands that you need to be aware of.
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1. The play button is important, but the tip here is you can play from anywhere. The main
one is on the left and that is for overall where the one on the right only plays that
particular segment that you are on.

2. Add Camera Path Animation button is the first button I use after I have created a new
Storyboard and is also the button I use after I use the Add Crane (and the like) button.
Failure to do this can result in choppy transitions.

3. The Add Crane, Add Look Around, Add Orbit are all perfect for keeping your camera still
while you trying to stay in a particular location. (see Add New KeyFrame)

4. Add a New Key Frame is probably the most critical because it helps us transition from
one angle to the next when creating a fly-through. Now it is important to understand that
this is especially critical after you use the Add Crane type of commands.  Immediately
following this you must use the Add Camera Path.

Here is a simple yet highly effective example

1. Start off either far away or directly on top of your site

2. Go into Storyboard and if a Storyboard is not created, create one.

3. Select the Add Camera Path Animation button
4. This will now capture your current position.
5. Now zoom/pan to your next position at the view point you want to be at.  (TIP: Making

hard right turns for example might take a little more finesse as you might want to add
more points of view.)
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6. We will go to this point.

7. Now we will hit the button in the right hand pane for Add a New Key Frame.

8. Now we can see how this transitions for us by hitting the top Play button. You should see
this transition for us real nicely.

9. First Rule of Video Making: Don’t give people motion sickness!
10. To prevent this we can control the speed at which each transition is by making our edits

in here. Now a cool tip is you can set the speed in one of them and you can use the
Keep Speed option so you do not have to keep adjusting it for the following frames. On
projects that have long roads I tend to go pretty fast but I make sure that I have a good
lead in time if while I am approaching my stopping place. This will make more sense
once you have made a couple of edits.

11. Now let’s zoom in on our pool area
12. Add another key frame. This locks our new position and will allow the smooth transition

when we go to produce the video.
13. Now let’s go and Add Crane.  Don’t ask me why but sometimes even though my Blue

Vertical line was at the end of my last camera path this new crane will show up at the
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beginning. The lesson here is that you need to check your storyboard area after every
add to ensure that something goofy did not get ordered incorrectly. If it does no worries
you should just be able to select and drag it into the correct place. Notice the Lock
camera on center of interest button and also notice that I did a crane up and a distance
up of 100’ above.

14. Notice that below I have the Blue Vertical line at the very end.

15. I always hit the play button before I use the crane or orbit type buttons. This way I know I
am exactly where the video is. If you fail to do this your video is going to look choppy but
hey pain is a great teacher.

16. Now I am going to use the Look Around type of animation found under the Crane. I want
to look more at the building so I am going to change my angle to 45 degrees.

17. If I am going to now switch back to the easy transition type of creation I need to use the
Add Camera Path Animation button before I move at all.  Make sure you do not make
any adjustments to the IW window between the Add Crane, Look Around…. type of
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buttons and the Add Camera Path Animation.  We are simply creating a new starting
point. So let’s hit the Add Camera Path Animation button.

18. Now pan and zoom to our next location.

19. Basically for this demonstration we are going to assume we are done. Again the length
of our video is totally dependent on your needs just watch those transitions!

20. To generate the actual video for video you can use whatever settings you want but these
have worked well for us.

21. Hit the Export Storyboard to Video button
22. Follow these options and then just hit the Record button at the bottom.

Have fun and Best of Luck with your next IW project! Keep in mind there are lot’s of
internet videos out there on how to create videos and how to add certain additional
touches like logos, and intros (title button), and date and time, sky etc. So have fun with
those too!


